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Introduction
A correlation matrix shows, in brief, the interconnections between series of variables. It computes correlation coefficients between variables represented in the same sequence of rows and columns. 

Section 1 provides practical advice for making correlation matrix in SPSS for using cross-cultural data that contains ordinal scales. 

Section 2 is devoted to the decription of correlation matrix of interval variables which are taken from cross-cultural database World95.

Section 1: How to make correlation matrix

In order to produce correlation matrix in SPSS follow this path: Analyze → Correlate→ Bivariate. You will see the following picture:
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Choose “One-tailed” if you have a hypotheses about the ways each pair of variables is connected. In this case, you have to be able to suggest whether the direction of each correlation is negative or positive. If the correlation is positive, the increase of one parameter is accompanied by an increase of the other. If the correlation is negative, the decline of one variable is accompanied by the increase of the other. 


One shoud use Speaman's rank correlation coefficient when at least one out of two variables contains rank (ordinal) data. When both variables in each pair contain interval data, Pearson's correlation coefficient should be used. Speaman's rank correlation coefficient is usually denoted as Rho, and Pearson's coefficient is denoted as R. 

It is harder to establish the statistical significance of a correlation – the probability that it is due to random variation in the variables – without having a predefined hypothesis. A one-tailed test should be used only when the direction of the correlation (positive or negative) is predicted in advance. The main difference between one-tailed and two-tailed tests of the significance of correlation is that the probability of randomness will double in two-tailed tests. As a result, two-tailed tests are less significant. 


Let us produce a correlation matrix using the Standard Cross-Cultural Sample database. We will make a correlation matrix of the following valiables (V149–158): Writing and Records, Fixity of Residence, Agriculture, Urbanization, Technological Specialization, Land Transport, Money, Density of Population, Political Integration, Social Stratification. The data are coded by George Murdock, founder of American school of Cross-Cultural Studies (Murdock 1971). 

All these variables are indicators of cultural complexity of the societies. Cultural complexity is a widely used concept. Anthropologists generally accept that the human societies are becoming more complex with time, as a result of social evolutionary processes (see, for example, Levinson and Malone 1980). It is obvious that the United States, Russia, China or Mexico today is much more complex than rather small groups of hunter-gatherers which united our ancestors in Sub-Saharan Africa a hundred thousand years ago.

Since all the variables are indicators of the same parameter, which is cultural complexity, we should expect that all these variables correlate positively with each other. The higher population density, the large percentage of population that lives in cities, and so on. Thus, let we use “one-tailed” significance tests of the correlation. At the same time, all the indicators of cultural complexity are ordinal (ranked) variables. So we will have to use Spearman's correlation coefficient. After inserting the desired variables into the “Variables:” window, we will see the following picture on the screen. 
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In “Output” window we will see the following the correlation matrix. The rows and the columns of the correlation matrix are named after the titles of the chosen variables. They are listed in precisely the same order as they were requested. Each cell contains information about the correlation between each pair of variables. In the upper row of each cell we see the value of correlation coefficient and the direction of correlation, which is denoted by the sign. Minus usually indicates negative correlation (this doesn't happen in our case) and plus indicates a positive correlation. In the second row of each cell, we see the significance test for each correlation, i.e. the probability the this particular correlation is just a result of chance. Whenever significance is lower than 0.005, the correlation is considered highly statistically significant (less than one in a hundred times due to chance along). Such correlations are usually marked with asterisks. You see the owerwhelming majority of the correlations produced are positive and significant. The third row of each cell shows the number of cases that take part in the correlation. 

The best way to copy any table from SPSS Output to MS Word file is first to export the table to a file with .htm format, then open it and to copy the table from there to MS Word file. In order to do this, click on the table you need and make sure it is detached. Then follow the follwing path: “File” =>“Export.” Save the file with exported table in a suitable folder. After this open this file, copy the table and paste it into MS Word file. 

Whenever one publishes a correlation matrix, as in the Table below, one should denote significance as p for probability, Spearman's coefficient as Rho, and Pearson's coefficient as R. 
Table X. Correlations between the Indicators of Cultural Complexity 

	PRIVATE

	Writing and Records
	Fixity of Residence
	Agriculture
	Urbanization
	Technological Specialization
	Land Transport
	Money
	Density of Population
	Politcal Integration
	Social Stratification

	Writing and Records
	Rho
	
	.248
	.369
	.346
	.430
	.573
	.454
	.298
	.486
	.500

	
	p
	.
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001

	
	N
	
	186
	186
	186
	186
	186
	186
	186
	186
	186

	Fixity of Residence
	Rho
	.248
	
	.715
	.468
	.423
	<.001
	.424
	.720
	.425
	.475

	
	p
	<.001
	.
	<.001
	<.001
	<.001
	.498
	<.001
	<.001
	<.001
	<.001

	
	N
	186
	
	186
	186
	186
	186
	186
	186
	186
	186

	Agriculture
	Rho 
	.369
	.715
	
	.531
	.593
	.278
	.376
	.635
	.511
	.460

	
	p
	<.001
	<.001
	.
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001

	
	N
	186
	186
	
	186
	186
	186
	186
	186
	186
	186

	Urbanization
	Rho
	.346
	.468
	.531
	
	.437
	.328
	.337
	.566
	.470
	.461

	
	p
	<.001
	<.001
	<.001
	.
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001

	
	N
	186
	186
	186
	
	186
	186
	186
	186
	186
	186

	Technological Specialization
	Rho
	.430
	.423
	.593
	.437
	
	.494
	.433
	.486
	.569
	.582

	
	p
	<.001
	<.001
	<.001
	<.001
	.
	<.001
	<.001
	<.001
	<.001
	<.001

	
	N
	186
	186
	186
	186
	
	186
	186
	186
	186
	186

	Land Transport
	Rho
	.573
	<.001
	.278
	.328
	.494
	
	.317
	.137(*)
	.352
	.367

	
	p
	<.001
	.498
	<.001
	<.001
	<.001
	.
	<.001
	.031
	<.001
	<.001

	
	N
	186
	186
	186
	186
	186
	
	186
	186
	186
	186

	Money
	Rho
	.454
	.424
	.376
	.337
	.433
	.317
	
	.559
	.505
	.460

	
	p
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	.
	<.001
	<.001
	<.001

	
	N
	186
	186
	186
	186
	186
	186
	
	186
	186
	186

	Density of Population
	Rho
	.298
	.720
	.635
	.566
	.486
	.137(*)
	.559
	
	.577
	.535

	
	p
	<.001
	<.001
	<.001
	<.001
	<.001
	.031
	<.001
	.
	<.001
	<.001

	
	N
	186
	186
	186
	186
	186
	186
	186
	
	186
	186

	Political Integration
	Rho
	.486
	.425
	.511
	.470
	.569
	.352
	.505
	.577
	
	.688

	
	p
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	.
	<.001

	
	N
	186
	186
	186
	186
	186
	186
	186
	186
	
	186

	Social Stratification
	Rho
	.500
	.475
	.460
	.461
	.582
	.367
	.460
	.535
	.688
	

	
	p
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	<.001
	.

	
	N
	186
	186
	186
	186
	186
	186
	186
	186
	186
	


NOTE: All correlations are one-tailed. 


Let us analyze the contents of Table X. We see that practically all of the correlations are significant (p < 0.05) and positive. This means that all indicators of cultural complexity are interrelated rather cohesively. If a society has high population density, it is also likely to have settled population, intense agriculture, a developed land transportation system, writing and records, money, and so on. 


Now, let us produce a correlation matrix using cross-national data. Each user of SPSS has a file “World95” on his computer with SPSS. It is located in the folder “SPSS,” in “Program Files” folder, usually on disk C. “World95” is a small cross-national database which contains information on a couple dozen parameters of 109 countries for the year 1995. 

While the general trend of the evolution of pre-industrial societies is growing cultural complexity, the main path of modern history is modernization. Our ancestors used to have rather poor vehicles and very few facilities. They used to have many babies, but only some of them survived to older age. Average life expectancy did not exceed 40 years and they had rather good chances to die from infectious decease. Our contemporaries, in contrary, enjoy fast vehicles and abundant the facilities. They have fewer children but most of them survive. Finally, they live much longer and only very small percentage die from infections. In fact, modernization is in some ways continues the general evolutionary path of growing complexity. Modernized or developed societies are in many ways more complex than agrarian empiries of the past. 

Some countries joined modernization processes later than others. This allows us to produce the matrix of correlations between the indicators of modernization. 

Using the commands: “Analyze” => “Correlate” => “Bivariate,” we chose the following variables: “Average female life expectancy,” “Average male life expectancy,” “People who read (%),” “Infant mortality (deaths per 1000 live births),” “Gross domestic product / capita,” “Daily calorie intake,” “Birth rate per 1000 people,” “Death rate per 1000 people.” 

We suppose that all these parameters are indicators of modernization. Therefore, we have certain hypotheses about the way they should be connected. So, we choose our correlation to be “One-tailed.” All the variables that we chose are interval. If in some country women live for 40 years, in average, and in another country they live for 80 years, we can say indeed that women in the first country live twice longer than in the second one. So, we order “Pearson's” correlation coefficient. 
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This time we see that the correlations are much stronger than those between cultural complexity indicators. Again all of the indicators are significant (Table X). Consequently, if some country has largely literate population, it is also be denoted by high average life expectantcy for men and women, low infant mortality, low birth rate and death rate, comparatively high level of economic development (GDP per capita) and good nutrition for the citizens (Daily caloric consumption). In those countries that have begun modernization processes later than the developed countries, people have shorter lives, low level of education, larger families and smaller incomes and so on. 

If we compare cross-national data for 1970 and 2003, we shall see that the world moves further and further in the path of modernization. Birth rates decline even in the poorest countries. The decline of fertility has a very strong effect on the life of a society. The stabilization of population size leads to growing GDP per capita, and, as a result, to the development of education and health care, improving nutrition and quality of life.

[too many: and so on]. 

Table X. Correlations between the Indicators of Modernization 

	
	Average female life expectancy
	Average male life expectancy
	People who read (%)
	Infant mortality 
	Gross domestic product / capia
	Daily calorie intake
	Birth rate per 1000 people
	Death rate per 1000 people

	Average female life expectancy
	R
	
	.982
	.865
	-.962
	.642
	.775
	-.862
	-.696

	
	p
	.
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001

	
	N
	
	109
	107
	109
	109
	75
	109
	108

	Average male life expectancy
	R
	.982
	
	.809
	-.936
	.639
	.765
	-.805
	-.739

	
	p
	<0.001
	.
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001

	
	N
	109
	
	107
	109
	109
	75
	109
	108

	People who read (%)
	R
	.865
	.809
	
	-.900
	.552
	.682
	-.869
	-.486

	
	p
	<0.001
	<0.001
	.
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001

	
	N
	107
	107
	
	107
	107
	74
	107
	106

	Infant mortality (deaths per 1000 live births)
	R
	-.962
	-.936
	-.900
	
	-.640
	-.777
	.865
	.630

	
	p
	<0.001
	<0.001
	<0.001
	.
	<0.001
	<0.001
	<0.001
	<0.001

	
	N
	109
	109
	107
	
	109
	75
	109
	108

	Gross domestic product / capita
	R
	.642
	.639
	.552
	-.640
	
	.751
	-.651
	-.166

	
	p
	<0.001
	<0.001
	<0.001
	<0.001
	.
	<0.001
	<0.001
	.043

	
	N
	109
	109
	107
	109
	
	75
	109
	108

	Daily calorie intake
	R
	.775
	.765
	.682
	-.777
	.751
	
	-.762
	-.352

	
	p
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001
	.
	<0.001
	.001

	
	N
	75
	75
	74
	75
	75
	
	75
	75

	Birth rate per 1000 people
	R
	-.862
	-.805
	-.869
	.865
	-.651
	-.762
	
	.367

	
	p
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001
	<0.001
	.
	<0.001

	
	N
	109
	109
	107
	109
	109
	75
	
	108

	Death rate per 1000 people
	R
	-.696
	-.739
	-.486
	.630
	-.166
	-.352
	.367
	

	
	p
	<0.001
	<0.001
	<0.001
	<0.001
	.043
	.001
	<0.001
	.

	
	N
	108
	108
	106
	108
	108
	75
	108
	


NOTE: All correlations are one-tailed. 

Levinson, David, and Martin, J. Malone. 1980. Towards Explaining Human Culture. New Haven: HRAF Press. 

Murdock, George P., and Caterina Provost. 1971. Measurement of Cultural 

 Complexity. Ethnology 12:379-392.
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